Scott Ciambor, State of Alaska Health and Social Services Planner
Alaska Mental Health Board/Advisory Board on Alcohol and Drug Abuse
Co-Chair, Juneau Homeless Coalition




Types of Housing Available in Communities
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Availability and Affordability

Availability: Housing Stock and Vacancy Rates

Affordability: Residents con5|dered burdened if paying more
than 30% of income on housing







* Emergency Shelters (Glory Hole, Aware, Inc.,
THRHA)

* Transitional Living (Gastineau Human Services,
Juneau Youth Services)

* Permanent Supportive Housing (JAMHI)

Public Housing

* AHFC Public Housing Division
e 1300 units of subsidized housing
* 4300 Housing Choice Voucher
* Juneau - 207 units, 334 vouchers

Other: Assisted Living/Senior Housing , Permanent

Affordable Housing

* Permanent Affordable Housing
(THRHA/AHDC)

Affordable Housing Stock Continuum of Care — Housing Targeting Homeless
Persons



Affordable Housing: HUD Continuum of Care Model

Permanent

Affordable

Outreach, Intake, Housing
Assessment
A Permanent

Transitional Supportive
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Juneau: HUD Continuum of Care Survey
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Total Number of Continuum of Care Programs of Each Type In Juneau %

4 8 12 14

Total Number of Beds Within Each Continuum of Care Program In Juneau

95 69 133 717

Agencies that Provide Supportive Services Only

——







Juneau Point In Time Homeless Count, 2008-2011
600 542 O Other

537

£ Victims of
Domestic

403

273 Violence

B Veterans

® Chronic
203 40 Substance
200 = Abuse

35 M Severely

Mentally 1l

™ Chronically
Homeless

2008 2009 2010 2011



Grantee Mame
Juneau Howsing
Trust

St Vimcent de Paul
Society

Juneau Alliamnce fior
Mental Health Inc
[JARIHI)
Tlingit-Haida
Regional Housimg
Awrthvority (THRHA)
Tlingit-Haida
Regional Housing
Authority (THRHA)
Juneau Howsing
Trust

Juneau Youth
Services (I75)

REACH, Imc.

REACH, Imc.

Juneau Housing
Trust
Tatal

Affordable Howsing Development in Juneau

Fiscal
Year

2001

2003

2003

2004

2005

2007

2008

2000

2010

2011

Grant
Funding Source Aurnunt
AHFC — HOME Commuunity
Land Trust 51968,000
D CED-Commnumity
Dievelopment Block Grant 500,000
AHFC — Special Meeds
Housing Grant (SMHG) 5008457
Low - Imcome Housing Tax
Credit (LIHTC) 556,231
Low - Imcome Housing Tax
Credit (LIHTC) 5437000
AHFC — HOME Commuunity
Land Trust 107,000
AHFC — Special Mesds
Housing Grant [SHNHG) 5724708
HUD-811, Mental Health
Trust Authority, & private
donations. 51,120,000
AHFC-Special Meads
Houwsing Grant & private
donations 5554 000
HUD- Meighborhood
Stabilization Program
(HSP 1) 5550, 032
£5 762 428
2000-20710;

Housing Type

Transitional
Pemnament
Supportive

Housimg

Single-Family

Single-Family
Single-Family

Transitional

Group home

Group home

Single-Family

income/faffordable housing units developed in the City and Borough of Juneau.

niits.
Created

1
(8 beds)
41

47

3
124

since 2000 therse have been

Homeownership
Partial Funding for
Paul's Place

Salmon Creek the
Lodge

Gladier Village |

Glacier Village |1 & 111
Homeowniership on
Land Trust FProperty
Cenali Transitional
Livimg Progrann

Mendenhall Woods
Group Home

Begin construction
fall 2010

To acquire and
rehabkilitate three
residential
properties; one
family to be 50% ANMI
or below,; one family
between 51-B0%
AR, and one family
between B1-120%
AMIL

124 vmnits of low-




Emergency Shelter for families

Housing First Model: Options for
hard-to-house, chronic
inebriates (0 to 30%AMI)

Supportive housing for seniors
Transition-age Youth

Aware, Inc. - Emergency Shelter
and meeting space

St. Vincent DePaul — 24 studio
apartments for low-income
housing

Vulnerability Index Survey &
Housing survey for hard-to-house,
chronic inebriates

Glory Hole/Northern Lights

Church/Yakoosge Daakahidi H.S. —
Emergency Youth Shelter



Affordable Housing Stock Continuum of Care — Housing Targeting Homeless Persons

* Emergency Shelters ( Glory Hole, Aware,
Inc.)

* Transitional Living (Gastineau Human
Services, JYS)

* Permanent Supportive Housing (JAMHI)

Public Housing

e  AHFC Public Housing Division
e 1300 units of subsidized housing
* 4300 Housing Choice Voucher
e Juneau - 207 units,

Other: Assisted Living/Senior Housing , Permanent Affordable Housing

* Permanent Affordable Housing
(THRHA/AHDC)




e Data: Point In Time Homeless Count

e Data & Outreach: Project Homeless Connect Event and report
e Data & Street Outreach: 100,000 Homes Campaign & Vulnerability Index
* Homeless Medical Respite Program
* Projects:
e St. Vincent DePaul
e AWARE, Inc.
* Emergency Youth Shelter

* Affordable Housing Focus Area * Juneau Affordable Housing Fund

* Supportive Housing Stock Survey * Juneau Affordable Housing Commission

* Housing First technical assistance

* Planning Commission: Zoning Changes
* Lands Department: Willoughby District
Land Use Plan & Studies of CBJ-owned

*  Homeless Community Coordination Program properties for housing.

* Special Needs Housing Grant Funding

* Representative Munoz H.B. 124 -
Property Tax deferral on subdivisions




* Define the local responsibility of the oversight of the housing systems
* Make projections/set goals for housing development

* Ten-Year Plan to End Homelessness — (housing targets and

e CBJ housing plan that includes targets

* Increased dialogue between property owners/private developers/social service
providers to find common ground and encourage development



SAMPLE SLIDES



State of Alaska

Alaska

In Alaska, the Fair Market Rent (FME]} for a owo-bedroom apariment 1= $985. In order to affiord this level of rend and
ufilitias — wathowt paying more than 3% of income on housimg - 2 housshold must earn 53,283 mondhly or $39,3599

annually. Assuming 3 40-hour worlk weelk, 52 weels per yaar, this level of income translages mio 2 Housing Wage of:
£18.94

In Alaska, 3 minimuom wage worker exrms an hourly wage of 37.75. In order to afford the FME for a2 owo-bedroom

aparitment, a mmmmum wage aarmer must work 98 howrs per week, 52 weeks per year. Or a housshold masst mchsda
24 mamdrmam wage exmers workimg 40 hoors per week year-roumd m order 6o make the two-bedroom FME affordable.

In Alaska, the estimared mean (average) wape for a render 15 $16.07. In order o afford the FME for a two-bedroom

apariment at this wage, 2 renter must work 47 hours per wesk, 532 weeks par year. Or, workmg 40 hours per wesk
year-roumd, a household muost mclude 1.7 worksrs eaming the mean renter wage in order o make the two-bedroom

FME affordable.

Monthiy Rent Affordable to Selected Income Levels
Compared with Two-Bedroom FMRE

T | betwoen Reni
Two Bodroom FMR [T $565 Eﬂﬁ;umhmd

Median Income Housaheld FMR
Muoan Remter Wags Earmer Miam BEeoter Wage Earmer  §150

Exeremly Low Incoma Houschold Exrremaly Low Inomne Homsohold 5364
Mintmom Wage Eamer Minimum Wage Eamer 581
&1 Becipions 551 Radpient  §776

50 500 §1,000 F¥1,500 52,000 ¥2.,500







Alaska
In Alaska, the Fair Market Rent (FME) for a two-bedroom apartment i $985. Inorder to afford this level of rent and
utilifies — without paying more than 30% of income on housing - 2 howsshold must earm $3, 763 monchly or $30, 399
annually. Assurming a 40-hour work week, b2 wagks per yaar, this level of income translates mito a2 Housmg Wage of:

£18.94

In Alaska, 3 minimum wage worker earms an hoorly wage of 37.75. In order o afford the FME for 3 two-bedmom

partment, a3 MMIMUm wage earmer must work 98 hours per week, 52 weeks per year. Or a housshold muest inclhsda
2.4 mindmum wage exmers workmg 40 hours per week year-round in order to make the two-bedroom FME affordabie.

In Alaska, the estimated mean (average) wage for a render 15 $16.07. In order to atford the FME for a cwo-bedroom
apartment at this wage, 2 renter must work 47 hours par weal, 52 weeks par year. Or, working 40 hours per wesk
year-roumd, a housshold must includs 1 2 workers saming the mean renter wage in order io make the two-bedroom

FMR affordable.

Monthiy Rent Affordable to Selected Income Lavels
Compared with Two-Bedroom FME

Gap batwoen Remt
Affordable amd

Two-Bedroom FME

Madizm fncome Honsdhold

Mnan Remter Wape Earner
Exzremaly Lovw Income Household
Mintmem Wage Eamer

55T Recipiome

Mazn Remtor Wage Eamar 5150
Extrumady Low Income Howschold 5354
Misimum Wage Eamer $587

S5l Rodpiemt 776 |

&0 %500 §1.000 §1,500 §2.000 §2.500



m 2004 m 2005 Average
200
150
100
50
0 .
Interest rates Currency rates Equity prices Commodity prices

Fiscal Year 2004

W 1st Qtr
 2nd Qtr
M 3rd Qtr
H 4th Qtr

B Gross Profit ' Net Revenue

10000

5000

1st Qtr

2nd Qtr

3rd Qtr 4th Qtr

Quarter Ended 1stQtr. 2ndQtr. 379 Qtr.  4thQtr. Total
Fiscal year 2003

Revenue $7,746  $8,541 $7,835 $8,065 $32,187
Gross profit 6,404 6,761 26,128
Net income

1,865 2,142 1,483 7,531
Basic earnings per share 0.17 '
Diluted earnings per share 0.19 0.17 0.2 0.14 0.69
Fiscal year 2004

Revenue $8,215 $10,153 $9,175  $9,292 $36,835

Diluted earnings per share 0.24 0.14 0.12 0.25 0.75

Fiscal year 2005

Revenue $10,818 $9,620 $10,161 $39,788
Gross profit 8,896 8,751 33,588
Net income 3,463 3,700 12,254
Basic earnings per share 0.32 0.34 1.13
Diluted earnings per share 0.23 0.32 0.23 0.34 1.12

(1) Includes charges totaling $750 million (pre-tax) related to the Fabrikam settlement and
$1.15 billion in impairments of investments.

(2) Includes stock-based compensation charges totaling $2.2 billion for the employee stock
option transfer program.

(3) Includes charges totaling $756 million (pre-tax) related to Contoso subsidiaries and other
matters.
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Financial Summary
80 Our perennial 3" Quarter boost was larger than expected
contributing to an exceptionally strong year. Distribution of sales
across the geographic markets looks fairly steady.
60
Our new product line, released this year, is early in its adoption
phase. We expect to see substantial revenue contribution from
40 these products over the next two years.
20
0

1st Qtr 2nd Qtr 3rd Qtr 4th Qtr




Market Share by Division

Product Division 2002 2003 2004 2005
Electronics 12.1% 132%
Consumer Goods 1.3% 2.3% 2.2% 2.7%

78.0% 82.3% 82.5% 84.0%

(1) Percentages based on domestic comparison to competitors in directly related
industries.

(2) Percentages based on standing at the end of each fiscal year.

(3) Values provided by a third party agency.

Organizational Structure

Contoso

Product Human

Finance
Development Resources

Quality
Assurance

Design Manufacturing

Headquarters Subsidiaries

Business Process Model

Operating

| |

Changing Supporting

» | 4

Optimizing

Summary

This has been a pivotal year for the company in growth, but also
development of our infrastructure and business processes. We'll
continue to focus on our internal systems over the next year.

Specific growth areas include Electronics where Contoso has seen
as 6.7% increase in market share over the last three years. An area
to monitor closely is the Services division where market share has
dropped slightly.
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About the Template

Pitchbooks are structured presentations with tightly packed text and graphics. They are usually intended for print rather than projection.
Some typical characteristics of a pitchbook presentation include:

1. Smaller text sizes and more dense content layouts to enable communication of large amounts of information
2. Simple graphical elements which print quickly and accurately
3. High degree of consistency between slides and among sections of slides

To start creating slides using this template, click the Home tab and then click to dropdown New Slide gallery.

Customizing the Logo Sections of Slides

To customize this template for your busineSS, you may want to To dIStInguISh between sections of slides while still maintaining
replace our generic logo with your own. the template’s simple look you can vary the colors of your slides:

1. Click on the Design tab

2. Right-click on a color set in the Theme Colors gallery
contoso ‘ | MB Logo . .
\ W " ! 3. Select the Apply to Selected Slides option

To do this for all of your slides, go into Slide Master View.

1. Click on the View tab
2. Click on the Slide Master view button

From here, you can add your own logo. You can also customize or - II ‘I
add additional layouts to create even more types of slides with i
this template.
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